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Important Information
Except as otherwise expressly stated in the License that accompanies a program, Texas Instruments makes 
no warranty, either express or implied, including but not limited to any implied warranties of 
merchantability and fitness for a particular purpose, regarding any programs or book materials and makes 
such materials available solely on an "as-is" basis. In no event shall Texas Instruments be liable to anyone 
for special, collateral, incidental, or consequential damages in connection with or arising out of the 
purchase or use of these materials, and the sole and exclusive liability of Texas Instruments, regardless of 
the form of action, shall not exceed the amount set forth in the license for the program. Moreover, Texas 
Instruments shall not be liable for any claim of any kind whatsoever against the use of these materials by 
any other party.

© 2021 Texas Instruments Incorporated

"Python" and the Python logos are trademarks or registered trademarks of the Python Software 
Foundation, used by Texas Instruments Incorporated with permission from the Foundation.
Actual products may vary slightly from provided images.
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Pythonプログラミング

TI-Nspire™製品では，Python(パイソン)を使って次のことができます。

  PythonプログラムをTNSファイルに追加します。
  テンプレートを使ってPythonプログラムを作成します。
  他のTI-Nspire™アプリとデータを共有します。
  TI-Innovator™ HubやTI-Innovator™ Roverを動かせます。

TI-Nspire™ Pythonは，マイクロコントローラーで実行するよう設計されたPython 3 標準ライ
ブラリのサブセットであるMicroPythonに基づいています。元のMicroPythonは，TIで使用で
きるように調整されています。

Note: 基礎となる数学機能の違いにより，数値の結果は電卓の結果と異なる場合があります。

Pythonは，次のTI-Nspire™製品で使用できます。

グラフ電卓 デスクトップソフトウェア

TI-Nspire™ CX II
TI-Nspire™ CX II CAS
TI-Nspire™ CX II-T
TI-Nspire™ CX II-T CAS
TI-Nspire™ CX II-C
TI-Nspire™ CX II-C CAS

TI-Nspire™ CX Premium Teacher Software
TI-Nspire™ CX CAS Premium Teacher Software
TI-Nspire™ CX Student Software
TI-Nspire™ CX CAS Student Software

Note: ほとんど機能はグラフ電卓ビューとソフトウェアビューで同じですが，いくつかの違い
が見られます。このガイドブックは，ソフトウェア上のグラフ電卓画面またはグラフ電卓そ
のものの画面を使っています。

Pythonモジュール

TI-Nspire™ Pythonは，次のモジュール(特定の機能を持った部品)を持っています。

標準モジュール TI モジュール

Math (数学)
Random (乱数)
Complex Math (複素数)
Time (時間)

TI PlotLib (ti̲plotlib)
TI Hub (ti̲hub)
TI Rover (ti̲rover)
TI System (ti̲system)
TI Draw (ti̲draw)
TI Image (ti̲image)

Note: 他のPython開発環境で作成されたPythonプログラムがある場合，TI-Nspire™ Python
で実行するには，編集が必要な場合があります。モジュールは，TIモジュールと比較して，
プログラム内で異なるメソッド，引数，メソッド順序を使う場合があります。一般に，任意
のバージョンのPythonとPythonモジュールを使う場合は，互換性に注意してください。
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Pythonプログラムを非TIプラットフォームからTIプラットフォームに，またはあるTI製品から
別のTI製品に転送する場合，次の点に注意してください。
  コア言語機能と標準ライブラリ(Math，Randomなど)を使うプログラムは，変更せずに移

植できます。
  PCまたはTIモジュール用のmatplotlibなどの，プラットフォーム固有のライブラリを使う

プログラムは，別のプラットフォームでの実行前に編集する必要があります。これは，TI
プラットフォーム間でも当てはまることがあります。

Pythonの他のバージョンと同様，特定のモジュールに含まれる関数，メソッド，定数を使うに
は，インポートを含める必要があります。たとえば，Mathモジュールからcos()関数を実行す
るには，次のコマンドを使います。

>>>from math import *
>>>cos(0)
1.0

メニューとその項目，説明については，Pythonメニュー(p.13)をご参照ください。

Pythonプログラムのモジュール化

Pythonプログラムをモジュールとして保存するには，次のようにします。
  エディタでは，Actions > Install as Python Module (アクション>Pythonモジュールとして

インストール)を選択します。
  シェルでは，Tools > Install as Python Module (ツール>Pythonモジュールとしてインスト

ール)を選択します。

選択すると，次のようになります。
  Python構文がチェックされます。
  ファイルが保存され，PyLibフォルダーに移動します。
  ファイルがモジュールとしてインストールされたことを確認するダイアログボックスが表

示されます。
  ファイルが閉じられ，モジュールが使えるようになります。
  モジュール名はMore Modules(その他のモジュール)メニューに追加されます。メニュー項

目にfrom <module> import *(<モジュール>からインポート*)が表示されます。

モジュールを他の人と共有するときは，次のガイドラインに従うことをお勧めします。
  TNSファイルに1つのモジュールのみを保存します。
  モジュール名はTNSファイルの名前と一致します(たとえば，"my_program"モジュールは

"my_program.tns"ファイルにあります)。
  Pythonエディタの前に，モジュールの目的，バージョン，関数を説明するメモページを

追加します。
  ver()関数を使ってモジュールのバージョン番号を表示します。
  (オプション)ヘルプ関数を追加して，関数内のメソッドのリストを表示します。
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Pythonワークスペース

Pythonプログラミングには，PythonエディタとPythonシェル(Shell)の2つのワークスペース
(作業場所)があります。

Pythonエディタ Pythonシェル

  Pythonプログラムを作成，編集，保存
  構文の強調表示と自動インデント(字下

げ)
  関数は引数で入力をガイドするインライ

ンプロンプト(行内の入力要請)
  有効な値を表示するツールチップ
  ½は現在のプログラムで定義されてい

るグローバルユーザー変数と関数を一覧
表示

  キーパッドのショートカット

  Pythonプログラムの実行
  小さなコードフラグメントのテストに便利
  以前の入力と出力を再利用するためシェル

履歴と相互に作業
  ½はプログラムで定義されたグローバル

ユーザー変数を一覧表示

Note: 1つのプロブレムには，複数のPythonプログラムとシェルを作成することができます。

Pythonエディタ

PythonエディタはPythonプログラムを作成，編集，保存できる場所です。

Pythonエディタページの追加

現在のプロブレムに新規Pythonエディタページを追加する
には，bを押して，Add Python > New (Pythonを追加>
新規)を選択します。

開いたダイアログボックスで，Name:はファイル名を入力します。Type:は空白のプログラム
やテンプレートを選択します。

空白のプログラム(Blank Program)          テンプレート
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プログラムを作成するとPythonエディタが表示されます。テンプレートを選択した場合，必要
なインポートステートメントが自動的に追加されます(以下を参照)。

Note: 他のアプリと同じように，1つのTNSファイルに複数のプログラムを含めることができ
ます。Pythonプログラムをモジュールとして使う場合，TNSファイルをPyLibフォルダーに保
存できます。そのモジュールは，他のプログラムやドキュメントで使用できます。

Math Calculations(数学計算)                    Random Simulations(乱数シミュレーション)

Geometry Graphics(幾何グラフ)             Image Processing(画像処理)

Plotting(x, y)&Text(プロットとテキスト)  Data Sharing(データ共有)

Hub Project(TI-Innovator Hub)              Rover Coding(TI-Roverコーディング)
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Pythonプログラムを開く

既存のPythonプログラムを開くには，~を押してInsert > Add Python > Open (挿入>Python
の追加>開く)を選択します。これにより，TNSファイルに保存されているプログラムのリスト
が表示されます。

プログラムの作成に使用されたエディタページが削除された場合でも，プログラムはTNSファ
イルで引き続き使用できます。

Pythonエディタでの作業

bを押すと，ドキュメントツールメニューが表示されます。これらのメニューオプションを
使うと，プログラムのコードブロックを追加，移動，コピーできます。

ドキュメントツールメニュー

モジュールメニューから選択した項目は，関数の各引数のインラインプロンプト(行内入力要
請)を持つコードテンプレートをエディタに自動的に追加します。e(進む)またはg＋e(戻
る)を押すと，ある引数から次の引数に移動できます。ツールチップやポップアップリストが
利用可能なとき表示されます。これは，必要な値を選択するのに役立ちます。

インラインプロンプト                   ツールチップ

ポップアップリスト



9

プログラム名の右側の数字は，現在カーソルがある行の番
号とプログラムの全行数を示しています。

現在のカーソル位置の上の行で定義されたグローバル関数
と変数は，hを押してリストから選択することができま
す。

プログラムにコードを追加すると，エディタはキーワード，
演算子，コメント，文字列，インデント(字下げ，薄い灰
色のひし形)を種々の色で表示して要素を識別しやすく
します。

プログラムの保存と実行

プログラムが終了したら，bを押してRun > Check Syntax & Save (実行>構文の確認と保存)
を選択します。これにより，Pythonプログラムの構文がチェックされ，TNSファイルに保存さ
れます。

Note: プログラムに変更があり未保存のときは，プログラム名の横にアスタリスク(*)が表示
されます。

プログラムを実行するには，bを押してRun > Run (実行>実行)を選択します(あるいはショ
ーカットキーで，/+Rと押します)。これにより，現在のプログラムが次ページのPythonシ
ェルページで実行されます。次ページがシェルでない場合は新規プログラムが新たに開いた
Pythonシェルページで実行されます。

Note: プログラムを実行すると，構文が自動的にチェックされ，プログラムは保存されます。
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Pythonシェル

PythonシェルはPythonプログラム，他のPythonコード，または単純なコマンドを実行するイ
ンタプリタ(interpreter)です。

Note: interpreterは「通訳者」の意味で，コンピュータでプログラムを実行する方法の1つで
す。プログラムを1命令ずつ変換して実行するため，動きを確認しながらコードを記述したり，
エラーが発生した個所をすぐに特定したりできます。

Pythonコード                                  簡単なコマンド

Pythonシェルページの追加

現在のプロブレムに新規のPythonシェルページを追加する
には，bを押してAdd Python > Shell (Pythonを追加>シ
ェル)を選択します。

Pythonシェルはbを押してRun > Run (実行>実行)を選
択しプログラムを実行することにより，Pythonエディタか
ら起動することもできます。

Pythonシェルでの作業

bを押すと，ドキュメントツールメニューが表示されま
す。これらのメニューオプションを使うと，コードのブロ
ックを追加，移動，コピーができます。

ドキュメントツールメニュー
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Note: 使用可能なモジュールからメソッドを使う場合，Pythonコーディング環境同様，必ず
最初にimport moduleステートメントを実行してください。

シェル出力の利用は，以前の入力や出力を選択してコピーできる電卓アプリに似ています。シ
ェル，エディタ，他のアプリの場所で使うことができます。

上矢印で選択し，コピーして目的の場所に貼り付けます。

最後に実行したプログラムのグローバル関数と変数は，hまたは/+Lを押してリストから
選択するか，bを押してVariables > Vars: Last Run Program (変数>変数：最後の実行プログ
ラム)を選択することで挿入できます。

最後に実行したプログラムとインポートしたモジュールのグローバル関数と変数のリストから
選択するには，bを押して，Variables > Vars: All (変数>変数：すべて)を選択します。

変数メニュー

最終実行プログラム変数                 すべての変数
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TI-Nspireのドキュメント

TI-Nspireはコンピュータと同じファイル構造，すなわちフォルダーがあっ
て，その中にドキュメントを作成・保存するという構造です。ドキュメント
は複数のプロブレム(Problem)からなり，各プロブレムには複数のページを作
成することができます。1ページが1画面にあたります。1つのドキュメントに
は最大30プロブレム，1つのプロブレムには最大50ページ作成できます。定義
された変数や関数は，作成されたプロブレム内のみ有効です。

同じプロブレムのPythonシェルページは，すべて同じ状態(ユーザー定義とインポートされた
変数定義)を共有します。そのプロブレムでPythonプログラムを保存または実行するか，b
を押してTools > Reinitialize Shell (ツール>シェルの再初期化)を選択すると，シェル履歴の背
景が灰色になり，前の状態が無効になったことを示します。

保存または再初期化する前              保存または再初期化後

Note: b Tools > Clear History(ツール>履歴のクリア)オプションは，シェル内の以前の入力
や出力をクリアしますが，変数は引き続き使えます。

メッセージ

Pythonセッション中に，エラーやその他の情報メッセージが表示される場合があります。プロ
グラムの実行時にシェルにエラーが表示されると，プログラムの行番号が表示されます。
/bを押してGo to Python Editor (Pythonエディタに移動)を選択します。エディタでbを
押し，Edit > Go to Line (編集>行に移動)を選択します。行番号を入力して·を押します。エ
ラーが発生した行の最初の文字にカーソルが表示されます。

実行中のプログラムの中断

プログラムまたは関数の実行中は，ビジーポインタ}が表示されます。

▶プログラムまたは機能を停止するには，
- Windows®：F12キーを押します。
- Mac®：F5キーを押します。
- グラフ電卓：cを押します。
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Pythonメニュー

このセクションでは，PythonエディタとPythonシェルのすべてのメニューとその項目，そし
てそれぞれの簡単な説明を一覧表示します。

Note: キーボードショートカットのあるメニュー項目の場合，Mac®ユーザーはCtrlを使用す
る場所で (Cmd)に置き換える必要があります。TI-Nspire™ハンドヘルドおよびソフトウェ
アショートカットの完全なリストについては，TI-Nspire™テクノロジーeGuideを参照してく
ださい。

Actions(アクション)メニュー........................................................................................ 14
Run(実行)メニュー.......................................................................................................... 14
Tools(ツール)メニュー ................................................................................................... 14
Edit(編集)メニュー.......................................................................................................... 15
Built-ins(組み込み)メニュー.......................................................................................... 16
Math(数学)メニュー........................................................................................................ 18
Random(乱数)メニュー .................................................................................................. 20
TI PlotLib(TI プロットライブラリ)メニュー ............................................................... 20
TI Hub(TI ハブ)メニュー ................................................................................................ 22
TI Rover(TI ローバー)メニュー ..................................................................................... 30
Complex Math(複素数)メニュー................................................................................... 36
Time(時間)メニュー ........................................................................................................ 36
TI System(TI システム)メニュー .................................................................................. 37
TI Draw(TI 描画)メニュー .............................................................................................. 38
TI Image(TI 画像)メニュー............................................................................................. 40
Variables(変数)メニュー ................................................................................................ 42
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Actions(アクション)メニュー

Note: これはエディタにのみ適用されます。

項目 説明

New 名前を入力し，新規プログラムのタイプを選択するNew(新規)ダイアロ
グボックスを開きます。

Open 現在のドキュメントで利用可能なプログラムのリストを開きます。

Create Copy 現在のプログラムを別の名前で保存できるCreate Copy(コピーを作成)
ダイアログボックスを開きます。

Rename 現在のプログラムの名前を変更するRename(名前の変更)ダイアログボ
ックスを開きます。

Close 現在のプログラムを閉じます。

Settings エディタとシェルの両方のフォントサイズを変更できるSettings(設定)
ダイアログボックスを開きます。

Install as Python 
module

現在のTNSファイルのPython構文をチェックし，それをPyLibフォルダ
ーに移動します。

Run(実行)メニュー

Note: これはエディタにのみ適用されます。

項目 ショート
カット

説明

Run Ctrl+R 構文をチェックし，プログラムを保存して，Pythonシェル
で実行します。

Check Syntax & Save Ctrl+B 構文をチェックし，プログラムを保存します。

Go to Shell なし 現在のプログラムに関連するシェルにフォーカスを移動す
るか，エディタの横に新しいシェルページを開きます。

Tools(ツール)メニュー

Note: これはシェルにのみ適用されます。

項目 ショート
カット

説明

Rerun Last Program Ctrl+R 現在のシェルに関連する最後のプログラムを再実行し
ます。
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Go to Python Editor なし 現在のシェルに関連するエディタページを開きます。

Run なし 現在のドキュメントで利用可能なプログラムのリスト
を開きます。
選択後，選択したプログラムが実行されます。

Clear History なし 現在のシェルの履歴をクリアしますが，シェルを再初
期化しません。

Reinitialize Shell なし 現在のプロブレムで開いているすべてのシェルページ
の状態をリセットします。
定義されたすべての変数とインポートされた関数は使
用できません。

dir() なし インポートステートメントの後に使用すると，指定し
たモジュールの関数のリストが表示されます。

From PROGRAM import * なし 現在のドキュメントで利用可能なプログラムのリスト
を開きます。
選択後，インポートステートメントがシェルに貼り付
けられます。

Install as Python Module なし バイナリ形式のモジュールに対してのみ有効になりま
す。現在のTNSファイルをPyLibフォルダーに移動しま
す。

Edit(編集)メニュー

Note: Ctrl+Aは，コードや出力のすべての行を選択します。これは，切り取りまたは削除(エ
ディタのみ)，またはコピーと貼り付け(エディタとシェル)のとき使います。

項目 ショートカッ
ト

説明

Indent TAB* 現在の行または選択した行のテキストをインデント
(字下げ)します。
*不完全なインラインプロンプト(行内入力要請)が
あるとき，TABは次のプロンプト(入力要請)に移動
します。

Dedent Shift+TAB** 現在の行または選択した行のインデント(字下げ)を
解除します(ディデント)。
**不完全なインラインプロンプト(行内入力要請)が
あるとき，Shift+TABを押すと前のプロンプト(入
力要請)に移動します。

Comment/Uncomment Ctrl+T 現在の行の先頭にコメント記号(#)を追加/削除しま
す。
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Insert Multi-line String なし (エディタのみ)複数行の文字列テンプレートを挿入
します。

Find Ctrl+F (エディタのみ) Find(検索)ダイアログボックスを開
き，現在のプログラムで入力された文字列を検索し
ます。

Replace Ctrl+H (エディタのみ) Replace(置換)ダイアログボックス
を開き，現在のプログラムで入力された文字列を検
索します。

Go to Line Ctrl+G (エディタのみ) Go to Line(行に移動)ダイアログボ
ックスを開き，現在のプログラムの指定された行に
ジャンプします。

Beginning of Line Ctrl+8 カーソルを現在の行の先頭に移動します。

End of Line Ctrl+2 カーソルを現在の行の末尾に移動します。

Jump to Top Ctrl+7 カーソルをプログラムの最初の行の先頭に移動しま
す。

Jump to Bottom Ctrl+1 カーソルをプログラムの最後の行の末尾に移動しま
す。

Built-ins(組み込み)メニュー

Functions(関数)

項目 説明

def function(): 指定された変数の関数を定義します。

return 関数によって生成された値を定義します。

Control(制御)

項目 説明

if.. 条件付きステートメント

if..else.. 条件付きステートメント

if..elif..else.. 条件付きステートメント

for index in range(size): ある範囲で繰り返します。

for index in range(start,stop): ある範囲で繰り返します。

for index in range (start,stop,step): ある範囲で繰り返します。
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for index in list: リストの要素を繰り返し処理します。

while.. 条件がFalseと評価されるまで，コードブロック内のス
テートメントを実行します。

elif: 条件付きステートメント

else: 条件付きステートメント

Ops(演算子)

項目 説明

x=y 変数の値を設定します。

x==y イコール(==)比較演算子を貼り付けます。

x!=y ノットイコール(!=)比較演算子を貼り付けます。

x>y より大きい(>)比較演算子を貼り付けます。

x>=y 以上(>=)比較演算子を貼り付けます

x<y より小さい(<)比較演算子を貼り付けます。

x<=y 以下(<=)比較演算子を貼り付けます。

and かつ(and)論理演算子を貼り付けます。

or または(or)論理演算子を貼り付けます。

not 否定(not)論理演算子を貼り付けます。

True Trueブール値を貼り付けます。

False Falseブール値を貼り付けます。

Lists(リスト)

項目 説明

[] ブラケット([])を貼り付けます。

list() 数列をリスト形式に変換します。

len() リストの要素数を返します。lenはlength(長さ)の省略形。

max() リストの最大値を返します。

min() リストの最小値を返します。

.append() このメソッドは要素をリストに追加します。
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.remove() このメソッドは要素の最初のインスタンスをリストから削除します。
(インスタンス：Pythonには文字型や数値型など様々な型があり，それら
の型の種類のことをクラスといいます。プログラムで実際に使うには型
を実体化します。型の実体のことをインスタンスといいます。)

range(start,stop,s
tep)

数値のセットを返します。

for index in 
range(start,stop,s
tep)

範囲を反復するために使用されます。

.insert() このメソッドは指定された位置に要素を追加します。

.split() このメソッドは指定された区切り文字で区切られた要素を持つリストを
返します。

sum() リストの要素の合計を返します。

sorted() ソートされたリストを返します。

.sort() このメソッドはリストをその場でソートします。

Type(タイプ)

項目 説明

int() 整数部分を返します。

float() 浮動小数点の値を返します。

round(x,ndigits) 指定された桁数に四捨五入した浮動小数点の数を返します。

str() 文字列を返します。

complex() 複素数を返します。

type() オブジェクトのタイプを返します。

I/O(入出力)

項目 説明

print() 引数を文字列として表示します。

input() ユーザーに入力を求めます。

eval() 文字列として表された式を評価します。

.format() このメソッドは指定された文字列をフォーマットします。
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Math(数学)メニュー

Note: このモジュールを使う新規プログラムを作成するときは，Math Calculations(数学計算)
プログラムタイプを使うことをお勧めします。これにより，関連するすべてのモジュールが
確実にインポートされます。

項目 説明

from math import * mathモジュールからすべてのメソッド(関数)をインポートします。

fabs() 実数の絶対値を返します。

sqrt() 実数の平方根を返します。

exp() e**xを返します。

pow(x,y) xyを返します。

log(x,base) logbase(x)を返します。底のないlog(x)は自然対数xを返します。

fmod(x,y) xとyのモジュール値を返します。xとyがfloatの場合に使用します。

ceil() 実数以上の最小の整数を返します。

floor() 実数以下の最大の整数を返します。

trunc() 実数を整数に切り捨てます。

frexp() 組(y, n)を返します。ここで，x==y*2**nです。

Const(定数)

項目 説明

e 定数eの値を返します。

pi 定数πの値を返します。

Trig(三角関数)

項目 説明

radians() 度単位の角度をラジアンに変換します。

degrees() ラジアン単位の角度を度に変換します。

sin() 引数のsin(正弦)をラジアンで返します。

cos() 引数のcos(余弦)をラジアンで返します。

tan() 引数のtan(正接)をラジアンで返します。

asin() 引数のアークサイン(逆正弦)をラジアンで返します。

acos() 引数のアークコサイン(逆余弦)をラジアンで返します。
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atan() 引数のアークタンジェント(逆正接)をラジアンで返します。

atan2(y,x) y/xのアークタンジェント(逆正接)をラジアンで返します。

Random(乱数)メニュー

Note: このモジュールを使う新規プログラムを作成するときは，Random Simulations(乱数シ
ムレーション)プログラムタイプを使用することをお勧めします。これにより，関連するすべ
てのモジュールが確実にインポートされます。

項目 説明

from random import * randomモジュールからすべてのメソッドをインポートします。

random() 0から1.0までの浮動小数点数を返します。

uniform(min,max) min<=x<=maxとなるような乱数x(float)を返します。

randint(min,max) 最小値と最大値の間のランダムな整数を返します。

choice(sequence) 空でない数列からランダムな要素を返します。

randrange(start,stop,step) 開始から停止までstep値ごと乱数を返します。

seed() 乱数生成を初期化します。

TI PlotLib(TI プロットライブラリ)メニュー

Note: このモジュールを使う新規プログラムを作成するときは，Plotting (x,y) & Textプログラ
ムタイプを使用することをお勧めします。これにより，関連するすべてのモジュールが確実
にインポートされます。

項目 説明

import ti̲plotlib as plt "plt"名前空間のti̲plotlibモジュールからすべてのメソッド
(関数)をインポートします。その結果，メニューから貼り
付けられた関数名の前にすべて"plt."が付きます。

Setup (設定)

項目 説明

cls() プロットキャンバスをクリアします。

grid(x-scale,y-scale,"style") x軸とy軸に指定されたスケールを使ってグリッド(格子)を表
示します。
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window(xmin,xmax,ymin,ymax) 指定された水平間隔(xmin, xmax)と垂直間隔(ymin, ymax)を
割り当てられたプロット領域(ピクセル)に対応させることに
より，プロットウィンドウを定義します。

auto̲window(x-list,y-list) auto̲window()の前にプログラムで指定されたx-listとy-list
内のデータ範囲に合うように，プロットウィンドウを自動
スケーリングします。

axes("mode") プロット領域の指定されたウィンドウに軸を表示します。

labels("x-label","y-label",x,y) 行位置x, yのプロット軸に"x-label"と"y-label"ラベルを表示
します。

title("title") ウィンドウの最上行中央に"title"を表示します。

show̲plot() バッファリング(緩衝)された図面出力を表示します。
use̲buffer()とshow̲plot()関数は，画面に複数のオブジェ
クトを表示すると遅延が発生する可能性がある場合に役立
ちます(ほとんどの場合は必要ありません)。

use̲buffer() オフスクリーンバッファ(off-screen buffer)を有効にして，
描画を高速化します。

Draw (描画)

項目 説明

color(red,green,blue) 以降のすべてのグラフ/プロットの色を設定します。

cls() プロットキャンバスをクリアします。

show̲plot() プログラムで設定したプロットの表示を実行します。

scatter(x-list,y-list,"mark") 指定されたマークスタイルで，(x-list, y-list)から順序対の数
列をプロットします。

plot(x-list,y-list,"mark") 指定されたx-listとy-listからの順序対を使って線をプロット
します。

plot(x,y,"mark") 指定されたマークスタイルで，x座標とy座標を使って点をプ
ロットします。

line(x1,y1,x2,y2,"mode") (x1,y1)から(x2,y2)までの線分をプロットします。

lin̲reg(x-list,y-list,"display") x-list, y-listの線形回帰モデルax＋bを計算して描画します。

pen("size","style") 次のpen()が実行されるまで，後続のすべての行の外観を設
定します。

text̲at(row,"text","align") 指定された"align"(位置合わせ)のプロット領域に"text"を表
示します。
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Properties (プロパティ)

項目 説明

xmin plt.xminとして定義されたウィンドウ引数に指定された変数。

xmax plt.xmaxとして定義されたウィンドウ引数に指定された変数。

ymin plt.yminとして定義されたウィンドウ引数に指定された変数。

ymax plt.ymaxとして定義されたウィンドウ引数に指定された変数。

m プログラムでplt.linreg()が実行された後，傾きmと切片bの計算値はplt.mとplt.b
に格納されます。

b プログラムでplt.linreg()が実行された後，傾きaと切片bの計算値はplt.aとplt.b
に格納されます。

TI Hub(TI ハブ)メニュー

Note: このモジュールを使う新規プログラムを作成するときは，Hub Projectプログラムタイ
プを使用することをお勧めします。これにより，関連するすべてのモジュールが確実にイン
ポートされます。

項目 説明

from ti̲hub import * ti̲hubモジュールからすべてのメソッドをインポートします。

Hub Built-in Devices > Color Output (ハブ内蔵デバイス>色出力)

項目 説明

rgb(red,green,blue) RGB LEDの色を設定します。

blink(frequency,time) 選択した色の点滅頻度と持続時間を設定します。

off() RGB LEDをオフにします。

Hub Built-in Devices > Light Output (ハブ内蔵デバイス>光出力)

項目 説明

on() LEDをオンにします。

off() LEDをオフにします。

blink(frequency,time) LEDの点滅頻度と持続時間を設定します。
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Hub Built-in Devices > Sound Output (ハブ内蔵デバイス>サウンド出力)

項目 説明

tone(frequency,time) 指定された周波数のトーンを指定された時間再生します。

note("note",time) 指定されたノートを指定された時間再生します。
ノートは，ノート名とオクターブを使って指定されます。
例：A4，C5
ノート名は，C, CS, D, DS, E, F, FS, G, GS, A, AS, Bです。
オクターブ数の範囲は1～9です。

tone(frequency,time,tempo) 指定された時間とテンポで指定された周波数のトーンを再生し
ます。
テンポは，0～10の範囲の1秒当たりのビープ音の数を定義し
ます。

note("note",time,tempo) 指定された時間とテンポで指定されたノートを演奏します。
ノートは，ノート名とオクターブを使って指定されます。
例：A4，C5
ノート名は，C, CS, D, DS, E, F, FS, G, GS, A, AS, Bです。
オクターブ数の範囲は1～9です。
テンポ番号の範囲は0～10です。

Hub Built-in Devices > Brightness Input (ハブ内蔵デバイス>明るさ入力)

項目 説明

measurement() 内蔵のBRIGHTNESS(光レベル)センサを読み取り，読み取り値
を返します。
既定値の範囲は0～100です。これは，range()関数を使って変
更できます。

range(min,max) 光レベルセンサからの読み取り値をマッピングするための範囲
を設定します。両方が欠落している場合，または値がNoneに設
定されている場合は，既定値の明るさの範囲である0～100が設
定されます。

Add Input Device (入力デバイスの追加)

このメニューには，ti̲hubモジュールでサポートされているセンサ(入力デバイス)のリストが
あります。すべてのメニュー項目はオブジェクト名を貼り付け，センサで使用される変数とポ
ートが表示されます。各センサには，センサの値を返すmeasurement()メソッドがあります。

項目 説明

DHT (Digital Humidity & 
Temp)

現在の温度，湿度，センサタイプ，最後にキャッシュされた読み
取りステータスから成るリストを返します。
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Ranger 指定された超音波レンジャー(ultrasonic ranger)からの現在の距離
の測定値を返します。
  measurement_time() － 超音波信号がオブジェクトに到達する

のにかかる時間(飛行時間)を返します。

Light Level 外部の光(brightness)センサからの明るさレベルを返します。

Temperature 外部の温度センサからの温度の測定値を返します。
既定値の設定では，IN 1，IN 2，IN 3ポートでSeeed温度センサを
サポートします。
TI Innovator™Hubのブレッドボードパック(Breadboard Pack)の
TI LM19温度センサを使うには，使用中のBBピンへのポートを編
集し，オプションの引数"TIANALOG"を使います。
例：mylm19=temperature("BB 5", "TIANALOG")

Moisture 湿度センサの読み取り値を返します。

Magnetic 磁場の存在を検出します。
フィールドの存在を判別するしきい値(threshold value)は，
trigger()関数を介して設定されます。
しきい値の既定値は150です。

Vernier コマンドで指定されたVernierアナログセンサから値を読み取りま
す。次のVernierセンサをサポートしています。
  temperature (温度) －ステンレススチール温度センサ
  lightlevel (光) － TI光レベルセンサ
  pressure (圧力) － 旧ガス圧力センサ
  pressure (圧力) － 新しいガス圧力センサ
  pH (pH) － pHセンサ
  force10 (力) － ±10N設定，デュアルフォースセンサ
  force50 (力) － ±50N設定，デュアルフォースセンサ
  accelerometer (加速度) － Low-G(低G)加速度計
  generic (ジェネリック，汎用) － 上記でサポートされていない
他のセンサの設定や方程式の係数を設定するcalibrate() APIの使
用を許可します。

Analog In アナログ入力ジェネリックデバイスの使用をサポートします。

Digital In DIGITALオブジェクトに接続されているデジタルピンの現在の状
態，またはオブジェクトに最後に設定されたデジタル出力値のキ
ャッシュされた状態を返します。

Potentiometer ポテンショメータ(可変抵抗器)センサをサポートします。
センサ範囲はrange()関数で変更できます
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項目 説明

Thermistor サーミスタセンサ(温度変化により抵抗値が変化するセンサ)を読
み取ります。
既定値の係数は，10KΩの固定抵抗とともに使った場合，TI-
Innovator™Hubのブレッドボードパック(Breadboard Pack)に含
まれているサーミスタと一致するように設計されています。
サーミスタの新しいキャリブレーション係数と基準抵抗のセット
は，calibrate()関数を使って設定できます。

Loudness 音センサ(sound loudness sensor)をサポートします。

Color Input I2C接続のカラー入力センサへのインターフェースを提供しま
す。
I2Cポートに加えてbb̲portピンを使って，カラーセンサのLEDを
制御します。
  color_number(): センサが検出している色を表す1～9の値を返

します。数字は次のマッピングごとの色を表しています:
1: Red (赤)
2: Green (緑)
3: Blue (青)
4: Cyan (シアン，青緑色)
5: Magenta (マゼンタ，赤紫色)
6: Yellow (黄)
7: Black (黒)
8: White (白)
9: Gray (グレー)

  red(): 検出されている赤の色レベル強度を表す0～255の値を返
します。

  green(): 検出されている緑の色レベル強度を表す0～255の値を
返します。

  blue(): 検出されている青の色レベル強度を表す0～255の値を返
します。

  gray(): 検出されているグレーレベルを表す0～255の値を返し
ます。ここで，0は黒，255は白です。

BB Port 10個のBBポートピンすべてをデジタル入力/出力ポートの組み合
わせとして使うサポートをします。
初期化関数には，10ピンのサブセットの使用を可能にするオプシ
ョンの"mask"パラメータがあります。
  read_port(): BBポートの入力ピンの電流値を読み取ります。
  write_port(value): 出力ピンの値を指定された値に設定します。

値は0～1023です。マスクが指定されている場合，値は
var=bbport(mask)操作のマスク値に対しても調整されることに
注意します。
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Hub Time 内蔵のミリ秒タイマーへのアクセスを提供します。

TI-RGB Array TI-RGB Arrayをプログラミングするための関数を提供します。
初期化機能はオプションの"LAMP"パラメータを受け入れ，外部
電源を必要とするTI-RGB Arrayの高輝度モードを有効にします。
  set(led_position, r,g,b): 特定のled̲position(0～15)を指定され

たr, g, b値に設定します。ここで，r, g, bは0～255の値です。
  set(led_list,red,green,blue): "led̲list"で定義されたLEDを"red", 

"green", "blue"で指定された色に設定します。"led̲list"は0か
ら15までのLEDのインデックスを含むPythonリストです。たと
えば，set([0,2,4,6,15], 0, 0, 255)はLED 0, 2, 4, 6, 15を青色に
設定します。

  set_all(r,g,b): Array内のすべてのRGB LEDを同じr, g, b値に設定
します。

  all_off(): Array内のすべてのRGBをオフにします。
  measurement(): RGB ArrayがTI-Innovator™から使っているお

およその電流引き込みをミリアンペアで返します。
  pattern(pattern): 引数の値を0～65535の範囲のバイナリ値とし

て使うと，表現の1の値が存在するピクセルがオンになりま
す。LEDは255のpwmレベル値でREDとしてオンになります。

  pattern(value,red,green,blue): "pattern"で定義されたLEDを
"red", "green", "blue"で指定された色に設定します。

Add Output Device (出力デバイスの追加)

このメニューには，ti̲hubモジュールでサポートされている出力デバイスのリストがあります。
すべてのメニュー項目はオブジェクトの名前を貼り付け，デバイスで使われる変数とポートを
表示します。

項目 説明

LED 外部接続されたLEDを制御するための関数

RGB 外部RGB LEDの制御のサポート

TI-RGB Array TI-RGB Arrayをプログラミングするための関数を提供します。

Speaker TI-Innovator™ Hubで外部スピーカーをサポートするための関数
関数は上記の"sound"と同じです。

Power TI-Innovator™ Hubで外部電源を制御するための関数
  set(value): 電力レベルを指定された値(0～100)に設定します。
  on(): 電力レベルを100に設定します。
  off(): 電力レベルを0に設定します。
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Continuous Servo 連続サーボモータを制御する関数
  set_cw(speed,time): サーボは，指定された速度(0～255)で秒単

位の特定の時間，時計回りに回転します。
  set_ccw(speed,time): サーボは，指定された速度(0～255)で秒

単位の特定の時間，反時計回りに回転します。
  stop(): 連続サーボを停止します

Analog Out アナログ入力ジェネリック(汎用)デバイスを使うための関数

Vibration Motor 振動モーターを制御するための関数
  set(val): 振動モーターの強度を"val" (0-255)に設定します。
  off(): 振動モーターをオフにします。
  on(): 振動モーターを最高レベルでオンにします。

Relay リレーを制御するためのインターフェースを制御します。
  on(): リレーをオン状態に設定します。
  off(): リレーをオフ状態に設定します。

Servo サーボモータを制御する関数
  set_position(pos): スイープ(sweep)サーボ位置を－90～＋90の

範囲で設定します。
  zero(): スイープサーボをゼロ位置に設定します。

Squarewave 矩形波を生成するための関数
参考：Square wave(矩形波「くけいは」)とは非正弦波形の基
本的な一種で，電子工学や信号処理の分野で広く使われている
波です。

  set(frequency,duty,time): 既定値のデューティサイクルが50％(デ
ューティが指定されていない場合)および"frequence(周波数)"で
指定された出力周波数で出力矩形波を設定します。周波数は1～
500Hzです。デューティサイクルは，指定されている場合，0～
100％です。

参考：デューティサイクルまたはデューティ比とは，周期的な
現象において，"ある期間"に占める"その期間で現象が継続され
る期間"の割合です。制御，電気通信や電子工学で使います。

  off(): 矩形波をオフにします。

Digital Out デジタル出力を制御するインターフェース
  set(val): デジタル出力を"val"で指定された値(0または1)に設定

します。
  on(): デジタル出力の状態を高(1)に設定します。
  off(): デジタル出力の状態を低(0)に設定します。

BB Port TI-RGB Arrayをプログラミングするための関数を提供します。上
記の詳細を参照してください。
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Commands (命令)

項目 説明

sleep(seconds) 指定された秒数の間，プログラムを一時停止します。'time'モジ
ュールからインポートされます。

text̲at(row,"text","align") 指定された"align"(位置合わせ)のプロット領域に，指定された
"text"を表示します。ti̲plotlibモジュールの一部。

cls() プロット用のシェル画面をクリアします。ti̲plotlibモジュールの
一部。

while get̲key() != "esc": "esc"キーが押されるまで，"while"ループでコマンドを実行しま
す。

get̲key() 押されたキーを表す文字列を返します。
'1'キーは"1"を返し，'esc'は"esc"を返します，など。
パラメータなし- get̲key() -で呼び出されると，すぐに戻りま
す。
パラメータ- get̲key(1) -を指定して呼び出されると，キーが押
されるまで待機します。
ti̲systemモジュールの一部。
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OUT 1

OUT 2

OUT 3

IN 1

IN 2

IN 3

BB 1

BB 2

BB 3

BB 4

BB 5

BB 6

BB 7

BB 8

BB 9

BB 10

I2C

Ports (ポート)

以下は，TI-Innovator™ Hubで使用可能な入力ポートと出力ポートです。

項目
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TI Rover(TI ローバー)メニュー

Note: このモジュールを使う新規プログラムを作成するときは，Rover Codingプログラムタ
イプを使用することをお勧めします。これにより，関連するすべてのモジュールが確実にイ
ンポートされます。

項目 説明

import ti̲rover as rv "rv"名前空間のti̲roverモジュールからすべてのメソッド(関数)を
インポートします。その結果，メニューから貼り付けられた関数
名の前にすべて"rv."が付きます。

Drive (ドライブ)

項目 説明

forward(distance) Roverをグリッド単位で指定された距離だけ前方に移動します。

backward(distance) Roverをグリッド単位で指定された距離だけ後方に移動します。

left(angle̲degrees) Roverを指定された角度(度単位)で左に回します。

right(angle̲degrees) Roverを指定された角度(度単位)で右に回します。

stop() 現在の動きを即座に停止します。

stop̲clear() 現在の移動をただちに停止し，保留中のコマンドをすべてクリア
します。

resume() コマンド処理を再開します。

stay(time) Roverは，指定された時間(秒単位)の間，所定の位置に留まりま
す(オプション)。
時間が指定されていない場合，Roverは30秒間留まります。

to̲xy(x,y) Roverを仮想グリッド(virtual grid)上の座標位置(x, y)に移動しま
す。

to̲polar(r,theta̲degrees) Roverを仮想グリッド(virtual grid)上の極座標位置(r, theta)に移
動します。
角度は度で指定されます。

to̲angle(angle,"unit") 仮想グリッド(virtual grid)で指定された角度にRoverを回転させ
ます。
角度は，仮想グリッドのx軸を指すゼロ角度を基準にしていま
す。
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Drive > Drive with Options (ドライブ>オプション付きドライブ)

項目 説明

forward̲time(time) 指定された時間，Roverを前方に移動します。

backward̲time(time) 指定された時間，Roverを後方に移動します。

forward(distance,"unit") 指定された距離の間，既定値の速度でRoverを前方
に移動します。
距離は，グリッド単位，メートル，またはホイー
ルの回転数で指定できます。

backward(distance,"unit") 指定された距離の間，既定値の速度でRoverを後方
に移動します。
距離は，グリッド単位，メートル，またはホイー
ルの回転数で指定できます。

left(angle,"unit") Roverを指定された角度だけ左に回します。
角度は，度，ラジアン，gradian(グラード，1グラ
ードは直角(90度)の100分の1)で指定できます。

right(angle,"unit") Roverを指定された角度だけ右に回します。
角度は，度，ラジアン，gradian(グラード，1グラ
ードは直角(90度)の100分の1)で指定できます。

forward̲time(time,speed,"rate") 指定された速度で，指定された時間，Roverを前方
に移動します。
速度は，グリッド単位/秒，メートル/秒，ホイー
ル回転/秒で指定できます。

backward̲time(time,speed,"rate") 指定された速度で，指定された時間，Roverを後方
に移動します。
速度は，グリッド単位/秒，メートル/秒，ホイー
ル回転/秒で指定できます。

forward(distance,"unit",speed,"rate") 指定された速度で指定された距離だけRoverを前方
に移動します。
距離は，グリッド単位，メートル，ホイールの回
転数で指定できます。
速度は，グリッド単位/秒，メートル/秒，ホイー
ル回転/秒で指定できます。

backward(distance,"unit",speed,"rate") 指定された速度で指定された距離だけRoverを後方
に移動します。
距離は，グリッド単位，メートル，ホイールの回
転数で指定できます。
速度は，グリッド単位/秒，メートル/秒，ホイー
ル回転/秒で指定できます。
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Inputs (入力)

項目 説明

ranger̲measurement() Roverの前面にある距離センサ(ultrasonic distance sensor)
を読み取り，現在の距離をメートル単位で返します。

color̲measurement() 1から9までの値を返します。これは，Rover色入力センサに
よって感知される色を示します。
1＝red (赤)
2＝green (緑)
3＝blue (青)
4＝cyan (シアン，青緑色)
5＝magenta (マゼンタ，赤紫色)
6＝yellow (黄色)
7＝black (黒)
8＝grey (灰色)
9＝white (白)

red̲measurement() 色入力センサによって感知された赤のレベルを示す0～255
の値を返します。

green̲measurement() 色入力センサによって感知された緑のレベルを示す0～255
の値を返します。

blue̲measurement() 色入力センサによって感知された青のレベルを示す0～255
の値を返します。

gray̲measurement() 色入力センサによって感知された灰色のレベルを示す0～
255の値を返します。

encoders̲gyro̲measurement() 左右のホイールエンコーダーカウントと現在のジャイロ方
位を含む値のリストを返します。

gyro̲measurement() ドリフトを含む現在のジャイロの読み取り値を度単位の値
で返します。

ranger̲time() TI-Rover rangerからの超音波信号がオブジェクトに到達す
るまでにかかる時間("time of flight"「飛行時間」)を返しま
す。

Outputs (出力)

項目 説明

color̲rgb(r,g,b) Rover RGB LEDの色を，指定された赤，緑，青の
値に設定します。

color̲blink(frequency,time) 選択した色の点滅頻度と時間を設定します。

color̲off() Rover RGB LEDをオフにします。
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motor̲left(speed,time) 指定された時間，左側のモーター出力を指定され
た値に設定します。
速度は－255から255の範囲で，0が停止です。正
の速度は反時計回りの回転で，負の速度は時計回
りです。オプションの時間パラメータは，指定さ
れている場合，0.05～655.35秒の有効範囲を持ち
ます。指定されていない場合，既定値5秒が使用
されます。

motor̲right(speed,time) 指定された時間，右側のモーター出力を指定され
た値に設定します。
速度は－255から255の範囲で，0が停止です。正
の速度は反時計回りの回転で，負の速度は時計回
りです。オプションの時間パラメータは，指定さ
れている場合，0.05～655.35秒の有効範囲を持ち
ます。指定されていない場合，既定値5秒が使用
されます。

motors("ldir",left̲val,"rdir",right̲val,time) 左右のホイールを指定された速度レベルに設定し
ます。オプションの時間は秒単位です。
速度(left̲val, right̲val)の値は0から255の範囲
で，0は停止です。ldirとrdirパラメータは，それ
ぞれのホイールのCW(時計回り)またはCCW(反時
計回り)回転を指定します。オプションの時間パ
ラメータは，指定されている場合，0.05～655.35
秒の有効範囲を持ちます。指定されていない場
合，既定値5秒が使用されます。

Path (経路)

項目 説明

waypoint̲xythdrn() x座標，y座標，時間，進行方向，移動距離，ホイールの回転数，現
在の経路点のコマンド番号を読み取ります。これらすべての値を要
素として含むリストを返します。

参考：ウェイポイント(waypoint)とは，経路上の地点情報をいいま
す。一般的には，緯度と経度の情報の組です。

waypoint̲prev x座標，y座標，時間，進行方向，移動距離，ホイールの回転数，前
の経路点のコマンド番号を読み取ります。

waypoint̲eta 経路点まで運転する推定時間を返します。

path̲done() Roverが移動しているか(0)，移動が終了しているか(1)に応じて0ま
たは1の値を返します。

pathlist̲x() 最初から現在の経路点までのxの値のリストを返します。

pathlist̲y() 最初から現在の経路点までのyの値のリストを返します。
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pathlist̲time() 最初から現在の経路点までの時間のリストを秒単位で返します。

pathlist̲heading() 最初から現在の経路点までの進行方向のリストを返します。

pathlist̲distance() 最初から現在の経路点までの移動距離のリストを返します。

pathlist̲revs() 最初から現在の経路点までのホイールの回転数のリストを返しま
す。

pathlist̲cmdnum() 経路のコマンド番号のリストを返します。

waypoint̲x() 現在の経路点のx座標を返します。

waypoint̲y() 現在の経路点のy座標を返します。

waypoint̲time() 以前の経路点から現在の経路点への移動に費やされた時間を返しま
す。

waypoint̲heading() 現在の経路点の(絶対)方位を返します。

waypoint̲distance() 以前の経路点と現在の経路点の間の移動距離を返します。

waypoint̲revs() 以前の経路点と現在の経路点の間を移動するのに必要な回転数を返
します。

Settings (設定)

項目 説明

units/s 1秒あたりのグリッド単位での速度のオプション

m/s メートル/秒単位の速度のオプション

revs/s 1秒あたりのホイール回転数の速度のオプション

units グリッド単位での距離のオプション

m メートル単位の距離のオプション

revs ホイール回転数の距離のオプション

degrees 度単位の方向を変えるオプション

radians ラジアン単位の方向を変えるオプション

gradians グラード(1グラードは直角(90度)の100分の1)単位の方向を変えるオ
プション

clockwise ホイールの時計回りの方向を指定するオプション

counter-clockwise ホイールの反時計回りの方向を指定するオプション
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Commands (命令)

以下のコマンドは，TI-Roverモジュールだけでなく他のモジュールから集めた機能です。

項目 説明

sleep(seconds) 指定された秒数の間，プログラムを一時停止します。time(時間)
モジュールからインポートされます。

text̲at(row,"text","align") 指定された"align"(位置合わせ)のプロット領域に"text"を表示し
ます。ti̲plotlibモジュールからインポートされます。

cls() プロット用のシェル画面をクリアします。
ti̲plotlibモジュールからインポートされます。

while get̲key() != "esc": "esc"キーが押されるまで，"while"ループでコマンドを実行しま
す。

wait̲until̲done() Roverが現在のコマンドを終了するまで，プログラムを一時停止
します。
これは，Rover以外のコマンドをRoverのmotionと同期させるの
に便利な方法です。

while not path̲done() Roverがすべての動きを終えるまで，"while"ループでコマンド
を実行します。
path̲done()関数は，Roverが移動しているか(0)，移動が終了し
ているか(1)に応じて，0または1の値を返します。

position(x,y) 仮想グリッド上のRover位置を指定されたx, y座標に設定しま
す。

position(x,y,heading,"unit") 仮想グリッド(virtual grid)上のRoverの位置を指定されたx, y座
標に設定し，進行方向が指定されている場合は，仮想x軸を基準
にした仮想進行方向が設定されます(指定された角度の単位で)。
0から360までの正の角度は正のx軸から反時計回り，0から
－360までの負の角度は正のx軸から時計回りです。

grid̲origin() RVを(0,0)の現在のグリッド原点にあるように設定します。

grid̲m̲unit(scale̲value) 仮想グリッド(virtual grid)間隔をメートル/単位(m/unit)で指定
された値に設定します。0.1は既定値のm/unitであり，
     1単位=100mmまたは10cmまたは1dmまたは0.1m
に変換されます。
有効なscale̲valueの範囲は0.01～10.0です。

path̲clear() 既存の経路または経路点情報をすべてクリアします。

zero̲gyro() Roverジャイロを0.0の角度にリセットし，左右のホイールエン
コーダーカウントをクリアします。
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Complex Math(複素数)メニュー

このサブメニューはMore Modules (その他のモジュール)の下にあります

項目 説明

from cmath import * cmathモジュールからすべてのメソッドをインポートします。

complex(real,imag) 複素数を返します。

rect(modulus,argument) 極座標の複素数を直交座標に変換します。

.real 複素数の実部を返します。

.imag 複素数の虚部を返します。

polar() 直交座標の複素数を極座標に変換します。

phase() 複素数の偏角(位相)を返します。

exp() e**xを返します。

cos() 複素数のcosを返します。

sin() 複素数のsinを返します。

log() 複素数の自然対数を返します。

log10() 複素数の，10を底とする対数を返します。

sqrt() 複素数の平方根を返します。

Time(時間)メニュー

このサブメニューはMore Modules (その他のモジュール)の下にあります

項目 説明

from time import * time(時間)モジュールからすべてのメソッドをインポートします。

sleep(seconds) 指定された秒数の間，プログラムを一時停止します。

clock() 現在のプロセッサ時間を秒単位の浮動小数点数として返します。

localtime() 2000年1月1日から秒で表される時間を，年，月，日，時，分，秒，平
日，年日，夏時間(DST:Daylight Savings Time)フラグを含む9タプル(要
素の追加や削除ができないリスト)に変換します。オプション(seconds)
引数が指定されていない場合は，リアルタイムクロック(内蔵時計)が使
用されます。

ticks̲cpu() 任意のreference point(参照ポイント)を持つプロセッサ固有の，増加す
るミリ秒カウンタを返します。異なるシステム間で一貫して時間を測定
するには，ticks̲ms()を使用します。
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ticks̲diff() ticks̲cpu()またはticks̲ms()への連続した呼び出し間の期間を測定しま
す。この関数は，長期間を測定するのに使用しないでください。

TI System(TI システム)メニュー

このサブメニューはMore Modules (その他のモジュール)の下にあります

Note: このモジュールを使う新規プログラムを作成するときは，Data Sharing(データ共有)プ
ログラムタイプを使用することをお勧めします。これにより，関連するすべてのモジュール
が確実にインポートされます。

項目 説明

from ti̲system import * ti̲systemモジュールからすべてのメソッド(関数)をインポー
トします。

recall̲value("name") "name"という名前の事前に定義されたOS変数(値)を呼び出し
ます。

store̲value("name",value) Python変数(値)を"name"という名前のOS変数に格納します。

recall̲list("name") "name"という名前の事前に定義されたOSリストを呼び出しま
す。

store̲list("name",list) Pythonリスト(リスト)を"name"という名前のOSリスト変数に
格納します。

eval̲function("name",value) 事前に定義されたOS機能を指定された値で評価します。

get̲platform() ハンドヘルドは"hh"を返し，デスクトップは"dt"を返します。

get̲key() 押されたキーを表す文字列を返します。
'1'キーは"1"を返し，'esc'は"esc"を返します，など。パラメー
タなしで呼び出されると(get̲key())，すぐに戻ります。
パラメータを指定して呼び出されると(get̲key(1))，キーが押
されるまで待機します。

get̲mouse() マウスの座標を2要素のタプル(要素の追加や削除ができないリ
スト)として返します。キャンバスのピクセル位置，またはキ
ャンバスの外側の場合は(－1,－1)のいずれかです。

while get̲key() != "esc": "esc"キーが押されるまで，"while"ループでコマンドを実行し
ます。

clear̲history() シェルの履歴をクリアします。

get̲time̲ms() ミリ秒単位の精度で時間をミリ秒単位で返します。
この機能は，実際の時刻を決定するのではなく，期間を計算す
るため使えます。
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TI Draw(TI 描画)メニュー

このサブメニューはMore Modules(その他のモジュール)の下にあります。

Note: このモジュールを使う新規プログラムを作成するときは，Geometry Graphics(幾何グラ
フ)プログラムタイプを使用することをお勧めします。これにより，関連するすべてのモジュ
ールが確実にインポートされます。

項目 説明

from ti̲draw import * ti̲drawモジュールからすべてのメソッドをインポートします。

Shape (形)

項目 説明

draw̲line() 指定されたx1, y1座標からx2, y2までの線を描画します。

draw̲rect() 指定された幅と高さで，指定されたx, y座標から始まる長方形を描画します。

fill̲rect() 指定された幅と高さで，指定されたx, y座標で始まり，指定された色で塗りつ
ぶされた長方形を描画します(定義されていない場合は，set̲colorまたは黒を
使用）。

draw̲circle() 指定された半径で，指定されたx, y中心座標から始まる円を描画します。

fill̲circle() 指定されたx, y中心座標から開始し，指定された半径で，指定された色で塗り
つぶされた円を描画します(定義されていない場合は，set̲colorまたは黒を使
用）。

draw̲text() 指定されたx, y座標で始まるテキスト文字列を描画します。

draw̲arc() 指定された幅，高さ，角度で，指定されたx, y座標から始まる円弧を描画しま
す。

fill̲arc() 指定されたx, y座標で開始し，指定された幅，高さ，角度で，指定された色で
塗りつぶされた円弧を描画します(定義されていない場合は，set̲colorまたは
黒を使用）。

draw̲poly() 指定されたx-list，y-list値を使って多角形を描画します。

fill̲poly() 指定されたx-list，y-list値を使って，指定された色で塗りつぶされた多角形を
描画します(定義されていない場合は，set̲colorまたは黒を使用）。

plot̲xy() 指定されたx, y座標と，さまざまな形状と記
号を表す1～13の指定番号を使って形状を描
画します(右図)。
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Control (制御)

項目 説明

clear() 画面全体をクリアします。x，y，幅，高さパラメータとともに使って，
既存の長方形をクリアできます。

clear̲rect() 指定された幅と高さで，指定されたx, y座標の長方形をクリアします。

set̲color() 別の色が設定されるまで，プログラムで続く形状の色を設定します。

set̲pen() 図形を描画するときに指定した境界線の太さとスタイルを設定します(塗
りつぶしコマンド(fill command)を使う場合は適用されません)。

set̲window() 図形が描画されるウィンドウのサイズを設定します。
この関数は，データに一致するようにウィンドウのサイズを変更した
り，描画キャンバスの原点(0, 0)を変更したりする場合に便利です。

get̲screen̲dim() 画面サイズのxmaxとymaxを返します。

use̲buffer() オフスクリーンバッファ(off-screen buffer)を有効にして，描画を高速化
します。

paint̲buffer() バッファリング(緩衝)された図面出力を表示します。
use̲buffer()とpaint̲buffer()関数は，画面に複数のオブジェクトを表示
すると遅延が発生する可能性がある場合に役立ちます。

Notes：
  既定値の設定では，画面の左上隅に原点(0, 0)があります。正のx軸は右を指し，正のy軸は

下を指します。これは，set̲window()関数を使って変更できます。
  ti̲drawモジュールの関数は，グラフ電卓とデスクトップのグラフ電卓ビューでのみ使用で

きます。
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TI Image(TI 画像)メニュー

このサブメニューはMore Modules(その他のモジュール)の下にあります。

Note: このモジュールを使う新規プログラムを作成するときは，Image Processing(画像処理)
プログラムタイプを使用することをお勧めします。これにより，関連するすべてのモジュー
ルが確実にインポートされます。

項目 説明

from ti̲image import * ti̲imageモジュールからすべてのメソッドをインポートし
ます。

new̲image(width,height,(r,g,b)) Pythonプログラムで使用するため，指定された幅と高さで
新しい画像を作成します。
新しい画像の色は(r, g, b)の値によって定義されます。

load̲image("name") Pythonプログラムで使用するため，"name"で指定された
画像をロードします。
画像は，NotesまたはGraphsアプリのいずれかで，TNSド
キュメントの一部である必要があります。
"name"プロンプトには，画像名(以前に名前が付けられて
いる場合)または挿入順序を示す番号が表示されます。

copy̲image(image) "image"変数で指定された画像のコピーを作成します。

画像オブジェクトのメソッド

画像オブジェクトに関連する追加の関数は，変数名の後にドッ
ト(.)を入力することによりエディタとシェルで使用できます。

  get_pixel(x,y): (x, y)座標で定義された位置にあるピクセルの(r, g, b)値を取得します。
px_val = get_pixel(100,100)

print(px_val)

  set_pixel(x,y,color_tuple): 位置(x, y)のピクセルをcolor̲tupleで指定された色に設定します。
set_pixel(100,100,(0,0,255))

(100, 100)のピクセルを(0,0,255)カラーに設定します。
  show_image(x,y): 画像を左上隅の位置(x, y)に表示します。
  w, h, name: 画像の幅，高さ，名前のパラメータを取得します。
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例
from ti_image import *

# An image has been previously inserted into the TNS document in a
Notes application and named "bridge"
im1=load_image("bridge")
px_val = im1.get_pixel(100,100)
print(px_val)

# Set the pixel at 100,100 to blue (0,0,255)
im1.set_pixel(100,100,(0,0,255))
new_px = im1.get_pixel(100,100)
print(new_px)

# Print the width, height and name of the image
print(im1.w, im1.h, im1.name)
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Variables(変数)メニュー

Note: これらのリストには，他のTI-Nspire™アプリで定義されている変数は含まれていませ
ん。

項目 説明

Vars: Current Program (エディタのみ) 現在のプログラムで定義されているグローバル関
数と変数のリストを表示します。

Vars: Last Run Program (シェルのみ) 最後に実行したプログラムで定義されたグローバル
関数と変数のリストを表示します。

Vars: All (シェルのみ) 最後に実行されたプログラムとインポートされたモ
ジュールの両方からのグローバル関数と変数のリストを表示しま
す。
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Pythonキーワード

次のキーワードは，TI-Nspire™ Pythonに組み込まれています。

False elif lambda

None else nonlocal

True except not

and finally or

as for pass

assert from raise

break global return

class if try

continue import while

def in with

del is yield
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Pythonキー対応

エディタやシェルにコードを入力するとき，キーパッドは適切なPython操作を貼り付ける，ある
いはメニューを開いて関数，キーワード，メソッド，演算子などを簡単に入力できるよう設計さ
れています。

キー 対応

h 変数メニューを開く

Ë ＝記号を貼り付け

. カーソルの左側の文字を削除

Ì 何もしない

= ＝記号を貼り付け

Í 選択した記号を貼り付け：
  >
  <
  !=
  >=
  <=
  ==
  and
  or
  not
  |
  &
  ∼

µ 選択した関数を貼り付け：
  sin
  cos
  tan
  atan2
  asin
  acos
  atan

Î ヒントを表示

Ï :=を貼り付け

l **を貼り付け

Ñ 何もしない

q **2を貼り付け
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キー 対応

Ò sqrt()を貼り付け

r かけ算記号(*)を貼り付け

Ó 二重引用符(")を1つ貼り付け

p わり算記号(/)を貼り付け

Ô 何もしない

u exp()を貼り付け

Õ log()を貼り付け

s 10**を貼り付け

Ö log(value,base)を貼り付け

( (を貼り付け

) )を貼り付け

Û [ ]を貼り付け

Ú { }を貼り付け

v 引き算記号(-)を貼り付け

Þ 現在の行の後に新しい行を追加

i Eを貼り付け

º 選択した記号を貼り付け：
  ?
  !
  $
  °
  '
  %
  "
  :
  ;
  ̲
  ¥
  #

¹ "pi"を貼り付け

; 既存のフラグの動作

@ 現在の行の後に新しい行を追加
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例：Pythonプログラム

以下のサンプルプログラムを使って，Pythonに慣れてください。これらは，Examplesフォルダ
ーにあるGetting Started Python.tnsファイルでも入手できます。

Note: インデント(字下げ)インジケーター(••)を含むサンプルコードをコピーしてTI-Nspire™
に貼り付ける場合は，それらは実際のインデントに置き換える必要があります。

Hello

# This program asks for your name and uses
# it in an output message.
# Run the program here by typing "Ctrl R"

name=input("What's your name? ")
print("Hello, ", name)
print("\n Press ctrl+R to run again")
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Loop Example

# This program uses a "for" loop to calculate
# the squares and cubes of the first 5 numbers
# 0,1,2,3,4
# Note: Python starts counting at 0

for index in range(5):
••square = index**2
••cube = index**3
••print("Index: ", index, "Square: ", square,
••••"Cube: ", cube)
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Heads or Tails

# Use random numbers to simulate a coin flip
# We will count the number of heads and tails
# Run the program here by typing "Ctrl R"

# Import all the functions of the "random" module
from random import *

# n is the number of times the die is rolled
def coin_flip(n):
••••heads = tails = 0
••for i in range(n):
# Generate a random integer - 0 or 1
# "0" means head, "1" means tails
••••side=randint(0,1)
••••if (side == 0):
••••••heads = heads + 1
••••else:
••••••tails = tails + 1
# Print the total number of heads and tails
••print(n, "coin flips: Heads: ", heads, "Tails: ", tails)

print("\nPress the Var key and select 'coin_flip()'")
print("In the ( ), enter a number of flips!")
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Plotting

# Plotting example
import ti_plotlib as plt

# Set up the graph window
plt.window(-10,10,-10,10)
plt.axes("on")
plt.grid(1,1,"dashed")
# Add leading spaces to position the title
plt.title("                TITLE")

# Set the pen style and the graph color
plt.pen("medium","solid")
plt.color(28,242,221)
plt.line(-5,5,5,-5,"arrow")

plt.pen("thin","dashed")
plt.color(224,54,243)
plt.line(-5,-5,5,5,"")

# Scatter plot from 2 lists
plt.color(0,0,0)
xlist=[1,2,3,4,5]
ylist=[5,4,3,2,1]
plt.scatter(xlist,ylist, "x")
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Drawing

from ti_draw import *

# (0,0) is in top left corner of screen
# Let's draw some circles and squares
# Circle with center at (50,50) and radius 40
draw_circle(50,50,40)

# Set color to red (255,0,0) and fill a rectangle of
# of width 180, height 80 with top left corner at
# (100,100)
set_color(255,0,0)
fill_rect(100,100,180,80)

# Set color to green and pen style to "thin"
# and "dotted".
# Then, draw a circle with center at (200,100)
# and radius 40
set_color(0,255,0)
set_pen("thin","dotted")
draw_circle(200,100,40)

set_color(0,0,0)
draw_text(20,200,"Press Enter to exit")
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Image

# Image Processing
#================================
from ti_image import *
from ti_draw import *
#================================

# Load and show the 'manhole_cover' image
# It's in a Notes app
# Draw a circle on top
im1=load_image("manhole_cover")
im1.show_image(0,0)
set_color(0,255,0)
set_pen("thick","dashed")
draw_circle(140,110,100)
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Hub
このプログラムは，Pythonを使って，プログラム可能なマイクロコントローラーであるTI-
Innovator™ Hubを制御します。TI-Innovator™ Hubを接続せずにプログラムを実行すると，エラ
ーメッセージが表示されます。
TI-Innovator™ Hubの詳細については，education.ti.comにアクセスしてください。

#========== Import Section ==========
from ti_hub import *
from math import *
from random import *
from time import sleep
from ti_plotlib import text_at,cls
from ti_system import get_key
#======== End of Import Section =======

print("Connect the TI-Innovator Hub and hit 'enter'")
input()
print("Blinking the RGB LED for 4 seconds")
# Set the RGB LED on the Hub to purple
color.rgb(255,0,255)

# Blink the LED 2 times a second for 4 seconds
color.blink(2,4)

sleep(5)
print("The brightness sensor reading is: ", brightness.measurement())

# Generate 10 random colors for the RGB LED
# Play a tone on the Hub based on the random
# color
print("Generate 10 random colors on the Hub & play a tone")
for i in range(10):
••r=randint(0,255)
••b=randint(0,255)
••g=randint(0,255)
••color.rgb(r,g,b)
••sound.tone((r+g+b)/3,1)
••sleep(1)

color.off()
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General Information
Online Help
education.ti.com/eguide

Select your country for more product information. Contact TI Support
education.ti.com/ti-cares

Select your country for technical and other support resources.

Service and Warranty Information
education.ti.com/warranty

Select your country for information about the length and terms of the warranty or about product service.

Limited Warranty. This warranty does not affect your statutory rights.

Texas Instruments Incorporated 12500 TI Blvd.

Dallas, TX 75243
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